
STATIKA   

LPPM Universitas Graha Nusantara  Volume 6, Nomor 1, April 2023 

https://jurnalugn.id/index.php/statika   p-ISSN : 2541-027X 

DOI  https://doi.org/10.64168/statika.v6i1.1090  e-ISSN : 2774-9509 

 

 

18 

 

Analisis Penjadwalan Proyek Gedung Puskesmas Padangmatinggi Kota 

Padangsidimpuan Menggunakan Metode CPM (Critical Path Method) 

  

Khoirul Isnandar1, Mhd. Rahman Rambe2, Nurkhasanah Rina Puspita3  

 
1*2,3 Teknik Sipil, Universitas Graha Nusantara  

 

Email: nandarshb@gmail.com  

  

 

Abstrak 

Dalam suatu proyek pembangunan, perencanaan merupakan masalah yang sangat penting.Dalam 

perencanaan manajemen waktu merupakan unsur penting didalamnya, dimana pengelolaan waktu 

mampu meminimalkan durasi yang mungkin tidak sesuai perkiraan pada saat pelaksanaan yang 

disebabkan beberapa faktor, seperti cuaca, ketersediaan bahan dan kendala pada saat pelaksanaan. Salah 

satu cara melakukan manajemen waktu penjadwalan adalah dengan menggunakan CPM (Critical Path 

Method). Pada penilitian ini pengolahan data yang digunakan pada penjadwalan metode CPM adalah 

data kuantitatif dengan metode analitis dan deskriptif korelasional. Data proyek yang akan digunakan 

adalah gambar proyek dan RAB. Data-data tersebut akan dianalisa dengan WBS (Work Breakdown 

Structure), perhitungan Man Power dan Man Days hingga hubungan logika ketergantungan sehingga 

diperoleh durasi dan jalur kritis bantuan software Microsoft Project. Proyek Penambahan Gedung / 

Ruang Baru Puskesmas Padangmatinggi dapat selesai selama 149 hari kerja, Dimana proyek dimulai 

pada tanggal 17 Juli 2020 dan selesai pada tanggal 12 Desember 2020. Dalam hal ini proyek dapat 

terselesaikan lebih cepat 1 hari dari waktu pelaksanaan kontrak.Pekerjaan yang berada di jalur kritis, 

yaitu: Pembongkaran dan Pembersihan, Membongkar Kolom, Pengukuran dan Pemasangan Bowplank, 

Galian Tanah Pondasi, Cor Lantai Kerja di Bawah Pondasi, Pembesian Pondasi Telapak,  

Pembesian/Tulangan Beton, Bekisting Balok Struktur Lt.2, Ring Balok B6 dan B5, Rangka Atap Baja 

Ringan, Atap Genteng Metal, Rabung Genteng Metal, Rangka Plafond Kayu, Plafond Multiplek, List 

Profil Kayu, List/Lat Kayu Plafon, Pengecatan Plafond Multiplek, Pengecatan 1 m2 tembok baru (1 lapis 

plamur, 1 lapis cat dasar 2 lapis cat penutup).  

  

Kata Kunci:  Penjadwalan, CPM, WBS, Durasi, Microsoft Project  
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PENDAHULUAN  

 Sebagai kota yang terus berkembang salah 

satunya melakukan pembangunan di 

berbagai sektor, baik itu pendidikan, 

perkantoran dan juga kesehatan untuk 

memenuhi kebutuhan dan kesejahteraan 

masyarakat. Dalam bidang kesehatan setiap 

wilayah perlu memiliki sarana pelayanan 

kesehatan seperti rumah sakit terutama 

puskesmas.Pembangunan suatu layanan 

kesehatan dalam hal ini puskesmas perlu 

perencanaan yang matang agar bangunan 

sesuai standar dan dapat diselesaikan tepat 

waktu sesuai dengan jadwal yang 

ditentukan. Untuk mendapatkan waktu 

yang efisien terdapat beberapa metode yang 

sering digunakan dalam menentukan 

penjadwalan antara lain metode PDM 

(Precedence Diagram Method) dan CPM 

(Critical Path Method), yang merupakan 

metode deterministik. Penjadwalan 

deterministik mengasumsikan bahwa durasi 

pekerjaan diketahui dengan pasti, padahal 

terdapat banyak ketidakpastian pada proses 

pelaksanaan suatu proyek, sesuai dengan 

karakteristik proyek konstruksi yaitu unik, 

dinamis dan cenderung kompleks. Semakin 

besar dan kompleks pembangunan sebuah 

proyek yang dikerjakan pastinya akan 

memerlukan manajemen yang tepat 

disebabkan sebuah proyek akan memiliki 

batas waktu (deadline) dari setiap aktivitas 

yang berlangsung, dimana artinya proyek 

tersebut harus diselesaikan sebelum atau 

tepat pada waktu yang telah ditentukan. 

Manajemen waktu yang baik merupakan 

unsur penting didalamnya, dimana 

pengelolaan waktu (durasi pengerjaan) 

yang tujuannya melalui manajemen waktu 

ini mampu meminimalkan durasi yang 

mungkin tidak sesuai perkiraan pada saat 

pelaksanaan, seperti faktor cuaca atau 

ketersediaan bahan dan kendala pada saat 

pelaksanaan. Metode yang digunakan untuk 

membuat suatu perkiraan rencana 

pelaksanaan proyek biasa dilakukan dengan 

metode penjadwalan Kurva S. Pada 

penelitian ini penulis akan membahas 

mengenai penggunaan metode penjadwalan 

CPM pada proyek gedung puskesmas 

dengan penjadwalan kurva S yang 

digunakan dilapangan. Berdasarkan latar 

belakang di atas, maka penulis ingin 

mencoba menganalisa penjadwalan proyek 

Penambahan Gedung / Ruang Baru 

Puskesmas Padangmatinggi, Kota 

Padangsidimpuan dengan menggunakan 

metode CPM (Critical Path Method) sesuai 

dengan standar dan peraturan yang berlaku.  

Adapun tujuan yang ingin dicapai dalam 

penelitian ini antara lain sebagai berikut:   

1. Mengetahui bagaimana penerapan 

metode penjadwalan CPM pada 

proyek Penambahan Gedung / 

Ruang Baru Puskesmas 

Padangmatinggi.   

2. Mengetahui durasi waktu yang 

dihasilkan menggunakan metode 

CPM tidak melewati waktu 

pelaksanaan pada kontrak.   

3. Untuk mendapatkan jalur kritis pada 

proyek Penambahan Gedung / 

Ruang Baru Puskesmas 

Padangmatinggi.  

1. Proyek  

 Proyek merupakan bagian dari program 

kerja suatu organisasi yang sifatnya 

temporer untuk mendukung pencapaian 

tujuan organisasi, dengan memanfaatkan 

sumber daya manusia maupun non sumber 
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daya manusia (Widiasanti I., dan 

Lenggogeni, 2013).   

 Dalam proses mencapai tujuan suatu 

proyek ada beberapa hal yang menjadi 

kendala suatu proyek, dimana dikenal 

dengan istilah triple constrain. Adapun 

kendala pada proyek yang dimaksud 

meliputi anggaran, jadwal dan mutu.  

  

2. Manajemen Proyek  

 Manajemen adalah kemampuan untuk 

memperoleh hasil dalam rangka pencapaian 

tujuan melalui kegiatan sekelompok 

orang.Untuk itu, tujuan perlu ditetapkan 

terlebih dahulu, sebelum melibatkan 

sekelompok orang yang mempunyai 

kemampuan atau keahlian dalam rangka 

pencapaian tujuan yang telah ditetapkan. 

Dengan kata lain, manajemen berfungsi 

untuk melaksanakan semua kegiatan yang 

diperlukan dalam pencapaian tujuan dengan 

batas-batas tertentu.   

 Menurut George R. Terry fungsi dari 

manajemen proyek terdiri dari Planning, 

Organizing, Actuating, Controlling 

(POAC).  

  

3. Work Breakdown Structure (WBS)  

 WBS merupakan susunan strukrur dan 

hierarki berupa diagram pohon (tree 

stnrcture diagram). Penyusunan WBS 

dilakukan dengan caratop down, dengan 

tujuan agar komponenkomponen kegiatan 

tetap berorientasi ke tujuan proyek (Husen, 

A., 2010).   

 Faktor-faktor yang dipertimbangkan dalam 

menentukan WBS secara umum disusun 

berdasarkan klasifikasi sebagai berikut:   

1. Pembagian berdasarkan area/lokasi 

yang berbeda.   

2. Pembagian kategori yang berbeda 

untuk tenaga kerja, peralatan dan 

material.  

3. Pembagian subdivisi pekerjaan 

berdasarkan spesifikasi pekerjaan.  

4. Pembagian pihak, seperti kontraktor 

utama, subkontraktor dan pemasok.  

4. Penjadwalan Metode Jaringan Kerja  

 Metode jaringan kerja merupakan cara 

grafis untuk menggambarkan kegiatan-

kegiatan dan kejadian yang diperlukan 

untuk mencapai tujuan proyek. Jaringan 

menunjukkan susunan logis antarkegiatan, 

hubungan timbal balik antara pembiayaan 

dan waktu penyelesaian proyek, dan 

berguna dalam merencanakan urutan 

kegiatan yang saling tergantung 

dihubungkan dengan waktu penyesuaian 

proyek.   

 Ada beberapa hal yang harus dilakukan 

terlebih dahulu dalam membuat metode 

jaringan kerja (Widiasanti I., dan 

Lenggogeni, 2013), yaitu:   

1. Menentukan aktivitas/kegiatan;   

2. Menentukan durasi aktivitas/kegiatan; 

3. Mendeskripsikan aktivitasi kegiatan; 

4. Menentukan hubungan yang logis.   

 Dalam melakukan perhitungan kebutuhan 

tenaga kerja dapat menggunakan rumus 

perhitungan menggunakan persamaan di 

bawah ini, yaitu:   

Jumlah Tenaga Kerja = Volume × 

Koefisien Tenaga Kerja   

  Adapun yang dimaksud dengan 

tenaga kerja di sini adalah banyaknya 

jumlah tenaga yang dibutuhkan untuk 

menyelesaikan bagian pekerjaan dalam satu 

kesatuan pekerjaan.  
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5. Kurva S  

 Kurva S adalah grafik yang dibuat dengan 

sumbu vertikal sebagai nilai kumulatif 

biaya atau penyelesaian (progress) kegiatan 

dan sumbu horizontal sebagai waktu. Kurva 

S dapat menunjukkan kemampuan proyek 

berdasarkan kegiatan, waktu darn bobot 

pekerjaan yang direpresentasikan sebagai 

persentase kumulatif dari seluruh kegiatan 

proyek. Visualisasi kurva S memberikian 

inforrnasi mengenai kemajuan proyek 

dengan mernbandingkan terhadap jadwal 

rencana. Uraian untuk mendapatkan nilai 

bobot pekerjaan digambarkan dalam skema 

sebagai berikut:  

  

Bobot (%) =  (V ×Harga Satuan Pekerjaan) 

X 100%  

        (Harga Bangunan)    

  

6. Metode CPM (Critical Path Method)  

 Critical Path Method atau jalur kritis, yaitu 

jalur yang memiliki rangkaian 

komponenkomponen kegiatan, dengan total 

jumlah waktu terlama dan menunjukkan 

kurun waktu penyelesaian proyek yang 

tercepat.  

  Jadi, jalur kritis terdiri dari rangkaian 

kegiatan kritis, dimulai dari kegiatan 

pertama sampai pada kegiatan terakhir 

proyek. Sebelum membuat jalur kritis 

dalam metode penjadwalan jaringan kerja 

dalam hal ini Activity on Arrow (AoA), 

haruslah diketahui terlebih dahulu cara 

perhitungan durasi proyek yang terbagi 

dalam hitungan maju dan hitungan mundur. 

Ada beberapa istilah yang terlibat 

sehubungan dengan perhitungan maju dan 

mundur metode AoA sebagai berikut :   

1. Early Start (ES) : waktu paling awal 

sebuah kegiatan dapat dimulai setelah 

kegiatan sebelumnya selesai. Bila 

waktu kegiatan dinyatakan atau 

berlangsung dalam jam, maka waktu ini 

adalah jam paling awal kegiatan 

dimulai.   

2. Late Start (LS) : waktu paling akhir 

sebuah kegiatan dapat diselesaikan 

tanpa memperlambat penyelesaian 

jadwal proyek.   

3. Early Finish (EF) : waktu paling awal 

sebuah kegiatan dapat diselesaikan jika 

dimulai pada waktu paling awalnya dan 

diselesaikan sesuai dengan durasinya. 

Bila hanya ada satu kegiatan terdahulu, 

maka EF suatu kegiatan terdahulu 

merupakan ES kegiatan berikutnya.   

4. Late Finish (LF) : waktu paling akhir 

sebuah kegiatan dapat dimulai tanpa 

memperlambat penyelesaian proyek.  

 Berikut adalah gambar potongan 

jaringan kerja AoA dengan penempatan 

ES, LS, EF, dan LF.  

  
 

Gambar 1. ES, LS, EF, LF  

(Sumber : Widiasanti I., dan Lenggogeni, 

2013)  

 Seperti telah disebutkan di atas, untuk 

mendapat angka-angka ES, LS, EF, dan LF, 

maka dikenal dua perhitungan dalam 

jaringan kerja AoA, yaitu perhitungan maju 

dan perhitunga, mundur.  

Perhitungan Maju: EF(i-j) = ES(i-j) + D(i-j)   

Perhitungan Mundur: LS(i-j) = LF(i-j) – 

D(i-j)  D = Durasi kegiatan i-j   

i 
ES 

j 
LS Kegiatan 

Durasi EF LF 
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7. Microsoft Project   

 Microsoft Project merupakan salah satu 

software  keluaranMicrosoft yang 

penggunaanya dikhususkan bagi manajer 

untuk membantu dalam mengelola proyek, 

baik itu proyek berskala kecil maupun skala 

besar (Santoso, E., dkk, 2014).   

 Pada tiap-tiap kegiatan memiliki hubungan 

saling berkaitan antara satu dengan yang 

lainnya atau bisa disebut dengan hubungan 

antar kegiatan.Hubungan antar kegiatan 

terdiri atas kegiatan yang mendahului 

(Predeccessor), kegiatan yang mengikuti 

(Successor) dan kegiatan yang bersamaan. 

Hubungan antar kegiatan pada penjadwalan 

menggunakan Microsoft Project dibedakan 

atas 4 jenis, diantaranya:  

Tabel 1. Jenis Hubungan Antar 

Kegiatan  

Jenis 

Hubungan  

Deskripsi  

Finish-to-

start  

Successor akan dimulai 

ketika predecessor selesai.  

start -to- 

start  

Predecessor dan successor 

dimulai pada waktu yang 

bersamaan. Tanggal 

dimulainya predecessor 

menentukan tanggal 

dimulainya successor.  

Finish-to-

finish  

Predecessor dan successor 

selesai pada waktu yang 

bersamaan. Tanggal 

selesainya predecessor 

menentukan tanggal 

dimulainya successor.  

start -to-

finish  

Successor akan selesai 

ketika predecessor dimulai. 

Gunakan hubungan ini 

untuk penyelesaian 

kegiatan yang terlambat, 

seperti untuk pencapaian 

atau tanggal selesai proyek.   

  (sumber: Abma, V., 2021)  

  

II.   METODOLOGI PENELITIAN   

 Pengolahan data pada metode penelitian 

yang digunakan adalah data kuantitatif 

dengan metode analitis dan deskriptif 

korelasional.Metode analitis berarti data 

yang sudah ada diolah sedemikian rupa 

sehinga menyajikan hasil akhir yang dapat 

disimpulkan. Sedangkan metode deskriptif 

korelasional menggunakan pendekatan 

kuantitatif dengan cara mendeskripsikan 

dengan maksud untuk menentukan unsur-

unsrunya, kemudian dianalisis bahkan juga 

diperbandingkan untuk mengetahui 

pengaruh suatu variabel terhadap variabel 

lainnya dalam model matematis. Adapun 

data yang akan digunakan sebagai pedoman 

dalam penulisan skripsi ini adalah :  

1. Data kontrak proyek; Gambar kerja; 

dan Rencana Anggaran Biaya (RAB) 

Dalam melakukan analisis dengan metode 

CPM ialah dengan sistematika analisis 

durasi proyek sebagai berikut :  

a) Mengkaji dan mengidentifikasi lingkup 

proyek, menguraikannya menjadi 

kelompok kegiatan yang merupakan 

komponen proyek.  

b) Data berupa gambar, analisa dan 

volume diidentifikasi dan diuraikan 

menjadi komponen yang lebih kecil 

dengan melakukan WBS (Work 

Breakingdown  

c) Structure).   
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d) Menyusun kembali komponen-

komponen dari masing-masing 

pekerjaan pada poin 1 menjadi mata 

rantai dengan urutan yang sesuai logika 

ketergantungan antara tiap pekerjaan 

berdasarkan berdasarkan studi literatur 

metode pelaksanaan pekerjaan gedung 

bertingkat.   

e) Menentukan logika ketergantungan 

antar kegiatan dilakukan dengan tiga 

kemungkinan hubungan, yaitu kegiatan 

yang mendahului (Predecessor), 

kegiatan yang didahului (Successor), 

serta bebas (Dummy).   

f) Memberikan perkiraan kurun waktu 

bagi masing-masing kegiatan yang 

dihasilkan dari pertimbangan dan 

perhitungan produktifitas pekerja, 

yaitu : durasi, jumlah pekerja (Man 

Power) dan produktifitas pekerja per 

hari (Man Days). Pada perhitungan ini 

peneliti akan menggunakan software 

bantuan berupa Microsoft Excel2010 

agar perhitungan lebih cepat 

diselesaikan   

g) Kemudian setelah itu dilanjutkan 

analisis jaringan kerja dengan metode 

CPM (Critical Path Method) 

menggunkan software Microsoft 

Project 2010 yang akan digunakan 

sebagai alat bantu untuk menganalisis 

jaringan kerja secara keseluruhan. 7.  

Setelah perhitungan pada poin.   

h) selesai dilakukan terhadap semua item 

pekerjaan maka akan ditentukan jalur 

kritisnya. Pekerjaan dapat dikatakan 

kritis apabila TF (Total Float) = 0.   

i) Langkah selanjutnya menggambar 

network planning CPM, menggunakan  

node yang didalamnya berisi nama, 

nomor atau kode, durasi, tanggal start 

dan finish dari kegiatan, lalu tanda anak 

panah yang menunjukkan arah dari 

kegiatan sebelumnya menuju kegiatan 

berikutnya, kode kegiatan yang sudah 

ditentukan otomatis oleh progam, 

durasi kegiatan yang sebelumnya 

dihitung pada poin 5, dummy dari 

kegiatan yang sudah ditentukan serta 

kegiatan kritis yang sudah didapat dari 

total float. Pada penggambaran 

network planning ini peneliti 

menggunakan bantuan software berupa 

Microsoft Project 2010.  

  
Gambar 2. Bagan Alir Penelitian   

(sumber: Dokumentasi pribadi)  

III.   HASIL DAN PEMBAHASAN   

  

 Proyek yang menjadi studi kasus pada 

penelitian ini telah selesai terlaksana pada 

tahun anggaran 2020.Dalam pengerjaannya 
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dibutuhkan beberapa data proyek yang 

menjadi data sekunder pada penelitian ini.   

1. Data KontrakProyek Data ini 

menjadi informasi awal yang harus 

dimiliki dalam melakukan penelitian ini 

karena di dalamnya terdapat beberapa 

informasi penting seperti, nama proyek, 

lokasi, waktu pelaksanaan dan lain 

sebagainya. Berdasarkan data data 

kontrak diketahui bahwa proyek 

Penambahan Gedung / Ruang Baru 

Puskesmas Padangmatinggi 

dilaksanakan pada tanggal 17 Juli 2020 

– 14 Desember 2020 atau lebih tepatnya 

150 hari.   

2. Gambar Kerja Gambar kerja pada 

proyek Penambahan Gedung/Ruang 

Baru Puskesmas Padangmatinggi 

sangat diperlukan dalam 

memvisualisasikan situasi dan kondisi 

bangunan. Gambar ini nantinya akan 

dibutuhkan dalam melakukan 

breakdown pekerjaan, dimana dapat 

diketahui apakah pekerjaan tersebut 

berada di satu lokasi atau tidak dan 

apakah diperlukan pembagian 

pekerjaan.   

3. Rencana Anggaran Biaya (RAB) 

Pada RAB proyek Penambahan Gedung 

/ Ruang Baru Puskesmas 

Padangmatinggi diperoleh item dan 

sub-item pekerjaan yang meliputi 

pekerjaan awal sampai dengan akhir 

proyek. Dalam RAB juga diperoleh 

volume pekerjaan dan kode analisa 

yang digunakan, dimana hal ini akan 

menjadi dasar perhitungan dan analisa 

dalam penelitian ini. Berikut adalah 

Item-item pekerjaan yang terdapat 

dalam penelitian ini:  

a) Pekerjaan Persiapan   

b) Pekerjaan Tanah   

c) Pekerjaan Pondasi   

d) Pekerjaan Struktur   

e) Pekerjaan Dinding   

f) Pekerjaan Pintu dan Jendela   

g) Pekerjaan Atap   

h) Pekerjaan Keramik Lantai dan 

Dinding   

i) Pekerjaan Plafond   

j) Pekerjaan Elektrikal  

k) Pekerjaan Sanitasi   

l) Pekerjaan Halaman dan Pagar.  

  

4. WBS(Work Breakdown Structure)   

 Untuk keperluan penelitian, maka sub 

pekerjaan pada RAB harus dilakukan 

breakdown dengan tujuan agar dapat 

melakukan analisa, khususnya pada 

analisa logika ketergantungan dan 

perhitungan durasi yang lebih akurat. 

Dalam melakukan breakdown 

diperlukan memilah dengan 

mengeluarkan kegiatan yang tidak 

mencirikan suatu aktivitas dan 

menggabungkan beberapa kegiatan 

menjadi satu kesatuan sesuai kebutuhan 

dalam penentuan predecessor. Setelah 

dilakukannya pemilahan tahapan 

selanjutnya adalah penentuan kode 

kegiatan dari setiap sub pekerjaan yang 

telah dipecah secara rinci agar 

memudahkan saat melakukan analisa. 

Dalam hal ini penulis menggunakan 

penomoran kolom tabel pada Task Sheet 

Microsoft Project sebagai kode agar 

sesuai dengan tampilan predecessor 

Microsoft Project nantinya.   
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5. Durasi Kegiatan Dan Jumlah 

Pekerja   

 Berikutnya adalah menentukan 

durasi pekerjaan dengan 

pertimbangan jumlah pekerja atau 

man power yang akan dipekerjakan. 

Berdasarkan analisa yang 

digunakan seluruh pekerjaan 

dilakukan secara manual, penulis 

menggunakan rumus persamaan 2.1 

yang sudah dijelaskan pada bab 2. 

Untuk lebih jelas dapat dilihat pada 

uraian pekerjaan cor lantai kerja di 

bawah pondasi  berikut ini:  

  

III. PEKERJAAN FONDASI  

1. Cor Lantai Kerja di Bawah Pondasi  

 
  V  =  1,94 m3  

  Durasi  =  1 hari  

  Koefisien  :  
Pekerja = 1,650 ; Tukang = 0,275 ; K.Tukang = 0,028; 

Mandor = 0,083  

  Maka,      

  Man power/OH  :    

  Pekerja =      Tukang =    K.Tukang =    

Mandor =     Jumlah OH 

 =  ∑OH =  3,20 + 0,53 

+ 0,05 + 0,16 =  4    

Perhitungan durasi juga bisa mengalami 

perubahan disebabkan pertimbangan 

terhadap man power yang digunakan, 

dimana hal ini bertujuan untuk mengontrol 

agar penggunaan man power lebih 

terorganisir.   

6. Hubungan Logika Ketergantungan   

 Untuk membuat suatu rangkaian diagram 

network, harus membutuhkan logika 

ketergantungan antara satu kegiatan dengan 

satu kegiatan lainnya agar diagram network 

tersebut lebih kompleks. Berdasarkan hasil 

analisa RAB dan gambar proyek 

Puskesmas Padangmatinggi, maka 

diperoleh hubungan logika ketergantungan 

sebagai berikut: Perlu diketahui pada 

Microsoft Project hubungan finish to start 

hanya menampilkan angka dari kode 

predecessor tidak seperti start to start dan 

finish to finish yang harus disertai huruf 

setelah angka.   

  

7. Analisis Critical Path Method (CPM)    

Menggunakan SoftwareMicrosoft 

Project Adapun langkah-langkah 

penyusunan  hingga menghasilkan 

network diagram dalam aplikasi 

Micosoft Project adalah sebagai berikut:   

1. Membuka lembar kerja baru.  

2. Menentukan tanggal dimulainya 

proyek Klik menu Project>Project 

Information. Pada kotak dialog 

Project Information dipilih Schedule 

from: Project Start Date dan 

memasukkan tanggal dimulainya 

proyek pada kotak Start Date.   

3. Menyusun kalender kerja. Untuk 

menentukan hari kerja dan jam kerja 

proyek apakah waktu kerja 

berdasarkan kalender atau hari-hari 

yang ditentukan dengan 

menambahkan hari libur. Klik menu 
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Tools>Change Working 

Time>Work Weeks>Details.   

4. Memasukkan data Task Name dan 

Duration Data Task Name dan 

Duration  yang dimaksud adalah 

aktifitas dan durasi dari tiap-tiap 

kegiatan pada poyek   

5. Menentukan Task Mode Pada kolom 

task mode terdapat pilihan antara 

“manually scheduled” dan “auto 

scheduled”. Dalam hal ini penulis 

memilih  “auto scheduled” agar 

penjadwalan dilakukan secara 

otomatis berdasarkan data hubungan 

antar pekejaan (predecessor) yang 

telah direncanakan.   

6. Menginput hubungan antara 

pekerjaan pada kolom Predecessors   

7. Melihat tampilan network diagram 

Klik menu View>Network diagram.  

 
Gambar 3. Diagram Batang / Gantt 

Chart Schedule  

(sumber: Hasil Penelitian 2022)  

  
Gambar 4.DiagramNetwork 

Schedule  

(sumber: Hasil Penelitian 2022)  

Setelah melakukan langkah-langkah di 

atas, maka dapat diketahui bahwa terdapat 

19 unit pekerjaan kritis atau termasuk 

kedalam critical path, dimana apabila 

pekerjaan tersebut terlambat 1 hari bisa 

menyebabkan keterlambatan seluruh item 

pekerjaan.   

1. Pembongkaran dan Pembersihan  

2. Membongkar Kolom = 3 pt  

3. Pengukuran dan Pemasangan 

Bouplank  

4. Galian Tanah Pondasi  

5. Cor Lantai Kerja di Bawah Pondasi  

6. Pembesian Pondasi Telapak  

7. Pembesian / Tulangan Beton  

8. Bekisting Balok Struktur Lt.2  

9. Ring Balok 15/25 fc' 9,8 Mpa / B6  

10. Ring Balok 15/20 fc' 9,8 Mpa / B5  

11. Rangka Atap Baja Ringan  

12. Atap Genteng Metal  

13. Rabung Genteng Metal  

14. Rangka Plafond Kayu 5/7 (Kayu 

Kelas II)  

15. Plafond Multiplek  

16. List Profil Kayu, motif  

17. List/Lat Kayu Plafon  

18. Pengecatan Plafond Multiplek  

19. Pengecatan 1 m2 tembok baru (1 

lapis plamur, 1 lapis cat dasar 2 lapis 

cat penutup)  

  

7. Pembahasan   

 Setelah dilakukan analisi CPM dengan 

aplikasi Microsoft Project 2010, dapat 

diketahui proyek Penambahan Gedung / 

Ruang Baru Puskesmas 

Padangmatinggi dapat selesai selama 

149 hari kerja atau proyek dimulai pada 

tanggal 17 Juli 2020 dan selesai pada 

tanggal 12 Desember 2020. Dimana 
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dalam hal ini proyek dapat terselesaikan 

lebih cepat 1 hari dari kontrak yang 

telah disepakati.Durasi ini didapatkan 

setelah melakukan pertimbangan dan 

kontrol terhadap man power yang 

digunakan sehingga proyek yang 

direncanakan dapat selesai dalam 149 

hari. Berdasarkan pekerjaan kritis yang 

didapat bisa dilakukan opsi percepatan 

(crashing) apabila ada pekerjaan yang 

mengalami keterlambatan sehingga 

mempengaruhi waktu rencana proyek. 

Dengan beberapa metode seperti 

penambahan jam kerja atau lembur dan 

penggunaan alat mekanis, hal ini bisa 

mempercepat suatu pekerjaan dengan 

pertimbangan kenaikan biaya yang 

timbul akibat percepatan tersebut.  

  

IV. PENUTUP  

  

1.  Kesimpulan  

 Berdasarkan studi kasus yang telah 

dilakukan pada proyek Gedung 

Puskesmas Padangmatinggi disertai 

dengan analisis pembahasan diperoleh 

beberapa kesimpulan, yaitu: Adapun 

penerapan dengan metode penjadwalan 

CPM ialah dengan tahapan melakukan 

breakdown pekerjaan terlebih dahulu 

lalu menentukan hubungan logika 

ketergantungan antar kegiatan 

kemudian melakukan analisa 

perhitungan durasi tiap pekerjaan. 

Sehingga didapatkan durasi 

keseluruhan pekerjaan dan lintasan 

kritisnya dengan bantuan aplikasi 

Microsoft Project 2010.  

Adapun durasi waktu yang didapatkan 

pada penjadwalan proyek Gedung 

Puskesmas Padangmatinggi adalah 149 

hari kerja, dimana proyek dimulai dari 

tanggal 17 Juli 2020 dan selesai pada 

tanggal 12 Desember 2020. Dalam hal 

ini proyek dapat terselesaikan lebih 

cepat 1 hari dari waktu pelaksanaan 

kontrak. Adapun hasil analisis 

penjadwalan proyek Gedung 

Puskesmas Padangmatinggi Kota 

Padangsidimpuan menggunakan 

metode CPM dengan bantuan aplikasi 

Microsoft Project 2010 dipeoleh 19 

item pekejaan yang berada di jalur 

kritis.  

  

2.  Saran  

`Dari hasil analisis yang diperoleh dari 

penyususan skripsi ini, diberikan saran-

saran sebagai berikut:  

1. Sebelum menentukan judul skripsi 

terkhusus bagi mahasiswa yang 

menggunakan data sekunder 

alangkah baiknya bila terlebih 

dahulu mengkonfirmasi pada 

pelaksana proyek apa saja data yang 

dapat digunakan dalam penelitian 

yang akan dilaksanakan.   

2. Bagi pemilik atau pelaksana proyek 

diharapkan menggunakan metode 

penjadwalan jalur kritis agar 

mengetahui pekerjaan yang harus 

dipercepat apabila terjadi masalah 

keterlambatan pada proyek.  

3. Diharapkan untuk penelitian 

berikutnya agar membuat pengaruh 

percepatan proyek terhadap biaya 

yang dikeluarkan.  

4. Diharapkan untuk penlitian 

berikutnya agar menambah anlisa 

percepatan seperti metode 
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penambahan jam kerja lembur, 

penambahan atau pergantian alat, 

dan penambahan tenaga kerja agar 

lebih banyak hasil yang bisa 

dipertimbangkan untuk melakukan 

percepatan durasi pekerjaan.  
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